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Abstract 

Surface runoff is a single most significant hydrological variable that is utilized in many civil works, 

planning for optimal usage of reservoirs, shaping rivers and flood control. Prediction and 

quantification of catchment runoff is a basic challenge in hydrology. In this study, estimation of 

floodwaters by Soil Conservation Services-Curve Number (SCS-CN) method using GIS was 

conducted. The important parameters include land use map, hydrologic soil groups, daily rainfall 

data and Digital Elevation Model (DEM). The land use data was derived from Landsat satellite 

images. Hydrological Soil Group (HSG) thematic map was also prepared based on the soil type, 

infiltration rate and percentage slope. A spatial union between the land use and HSG datasets was 

created to obtain Soil-Vegetation-Land use (SVL) complex which was then assigned the 

Antecedent Moisture Condition II (AMC II) Curve Numbers (CN) values based on respective 

classes. Weighted-CN was calculated as the product of CN-values and percentage areal coverage 

of respective classes hence resulting in a runoff potential map. Using daily precipitation data 

recorded in a weather station, sum of five-day prior precipitation was computed to give the AMC 

for each day. Revision of weighted AMC II was done based on AMC results. Direct daily runoff 

depth in the watershed was then computed using SCS-CN equation. The depth was later converted 

to runoff volume. It was revealed that runoff potential of the watershed is increasing at a very slow 

rate due to insignificant changes in land use. The annual runoff volume was found to range between 

7,120,686.458M3 during the period of low rains to 95,632,370.51 M3 during heavy rains. When 

daily runoff was computed from these results, the daily floodwaters volume was found to be 

comparable with the NCT value that was used to validate the results. 

Keywords: Surface runoff, SCS-CN, GIS, HSG, SVL complex.  
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CHAPTER 1: INTRODUCTION 

1.1 Background 

Runoff is the flowing or draining of rain water from a catchment area though a surface channel 

after satisfying all surface and sub-surface losses (Bhange, et al., 2014). Rainstorms usually 

generate runoff whose occurrence and quantity are determined mainly by the distribution, duration, 

intensity and the characteristics of the rainfall event. Also, soil type, vegetation cover, slopes and 

catchment type affects the occurrence and volume of runoff. 

The essence of estimating surface runoff is to provide important information on planning of water 

conservation measures, reducing the flooding hazards downstream which result in sedimentation, 

recharging the ground water zones, and assessment of water yield potential of the watershed. 

Watershed or catchment is an area covering all the land contributing runoff water to a common 

point known as pour point (Bhange, et al., 2014). 

Successful planning for a precipitation harvesting system must entail determination of Runoff 

behaviour. Early researchers on water harvesting often reported outcomes as an "annual 

percentage" which was pronounced as the proportion rainfall that ran off annually (Evett & Dutt, 

1985). However, (Shanan & Tadmor, 1979) warned against the use of annual runoff percentage in 

the design of micro-catchment systems. (Hollick, 1982) stated the weakness grieved by the annual 

runoff percentage as inability to gives an indication of the relationship between rainfall intensity, 

runoff and duration hence limiting extrapolation to drought years or new areas. 

Recently, GIS and remote sensing has proved to play a vital role in runoff modelling and 

identification of optimal sites for water harvesting or recharging structures (Padmavathy, et al., 

1993; El-Awar, et al., 2000; Ravishankar & Mohan, 2005; De Winnaar, et al., 2007). Hydrological 

modelling can hardly be performed without the incorporation of GIS as a tool due to its capacity 

to manage a large amount of spatial and attribute data (Bhange, et al., 2014). 

Attempts to estimate land cover parameters essential for runoff generation from remotely sensed 

data to up-scale field-based studies have been reported to be successful. Recent advances in spatial 

data processing in a GIS environment and remote sensing of land use/cover have led to the use of 

remotely sensed data in hydrological modelling (Senay & Verdin, 2004). Most of the work on 



 2 
 

adoption of remotely sensed data in hydrologic modelling has involved the use of SCS-CN runoff 

model due to its dependence on landcover material which is crucial when it comes to runoff. 

The most widely used approach for fast and accurate determination surface runoff within a 

watershed is the Curve Number method (SCS-CN). It involves the use of a simple empirical 

formula and readily available tables and curves. The curve numbers are determined by the 

hydrologic soil group (HSG) and land use. A small curve number means little runoff and high 

infiltration while a high curve number implies high runoff and low infiltration. The most unique 

thing with this method is its ability to incorporate the land use factor in the computation of runoff 

from precipitation data (Shadeed & Almasri, 2010). 

Water harvesting is a process of gathering and storing of surface runoff from a catchment area. It 

is a common practice in arid and semi-arid regions because they act as a source of water for diverse 

purposes when alternative sources such as wells, springs or streams dry up (Fraiser, 1980). 

(Rockstrom, 2000) presented an overview of different water harvesting methods in smallholder 

farms in Eastern and Southern Africa. Through this research, it was emphasized that ponds are 

among water storage structures that are rated highest in minimizing the danger of crops failing due 

to unpredictable rainfall in comparison to other water harvesting techniques. 

The SCS-CN approach has constraints that can be calibrated or modified for localized conditions. 

These constraints include the threshold antecedent soil moisture values (Mitchell, et al., 1993) and 

the initial abstraction (Sharama & Kumar, 2002). With modifications that assigned appropriate 

curve numbers to local specific cover types, researchers such as (Artan, et al., 2001) together with 

(Colombo & Sarfatti, 1997) have successfully demonstrated the application of the SCS CN 

Technique for estimation of runoff in African environments. 

Water has proved to be a vital necessity in social and economic development. The human 

population of Kenya and more specifically Nairobi City is ever increasing thereby raising the water 

demand required for domestic, industrial and other uses. However, the amount of rainfall, surface 

and sub-surface water sources available has either remained constant or declined over time. This 

has resulted in over-exploitation of these water sources hence leading to declining water table 

levels and water quality deterioration. Harvesting of surface runoff is hence the only untapped 

potential that can be utilized to salvage the situation by increasing water availability and recharging 

the water table in the process. 
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1.2 Problem Statement  

The Northern Collector Water Tunnel has been surrounded by many Controversies. However, the 

primary concern raised pertains the viability of the project based on the availability of the 

floodwaters along the three rivers (Irati, Gikigie, and Maragua) being focused on the project. Some 

of the project critics question the volumes of water along those rivers during the rainy seasons and 

have raised concerns that the project might interfere with the normal flow of the three rivers. 

As per the design specifications of the intake structures elaborated in NCT commissioning booklet, 

it’s clear that the Project will mostly abstract flood waters. This will help in lessening adverse 

effects of flooding downstream and associated landslides. Moreover, to guarantee constructive 

results in terms of water use with minimal effects downstream during heavy rains, the NCT project 

design has been limited to cumulatively abstract only forty three percent of the maximum 

floodwaters leaving fifty seven percent available for other investments in the storage infrastructure. 

This will ensure irrigation and storage reservoirs are not affected. 

The Athi Water board dispute is that only “excess” flood water will be diverted to the tunnel. But 

what exactly is “excess”? It is due to this reason that this study is going to utilize geospatial 

techniques (GIS and Remote Sensing) and try to quantify the “excess” floodwaters that are under 

dispute. From multitemporal drainage patterns observation, the average maximum floodwater at 

the three rivers abstraction points according to NCT booklet is estimated to be 1,198,368m3/day, 

and NCT will abstract 513,388 m3/day. However, the process of arriving at the values has not been 

justified. This study estimated the runoff volumes for four epochs with varying rainfall amount. 

1.3 Objectives 

1.3.1 The Overall objective 

To estimate the annual runoff potential of Northern Collector Water Tunnel project watershed by 

applying Soil Conservation Service-Curve Number (SCS-CN) method using GIS. 

1.3.2 The specific objectives 

➢ To investigate the impacts of changes in land use/cover on the rate of runoff 

➢ To assess the relationship between the amount of rainfall and corresponding resultant 

runoff 

➢ To investigate the applicability of SCS-CN method to the Kenyan environment.  
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1.4 Justification for the Study 

For a watershed to be properly managed, it is essential that the amount of runoff yield should be 

accurately estimated to establish its potential hence minimising chances of overexploitation which 

might result in adverse impacts (Gajbhiye, 2014). The water supply from rivers and other available 

sources is not sufficient and has been overexploited. Thus, for the usage of available water to be 

made efficiently to meet the people’s need and demand, other methods of water harvesting should 

be devised. Harvesting of flood water is one of the upcoming options which has not been fully 

exploited. 

This research shades light on the average volume of annual flood waters that are capable of being 

harvested from the ongoing NCT project hence justifying its viability to the critiques. The use of 

geospatial techniques has proved from existing literature to have successfully been applied to 

investigate and model hydrology (Bhange, et al., 2014; De Winnaar, et al., 2007; Gajbhiye, 2014). 

The results of all these literatures show successful research with positive outcome representing the 

watershed runoff capacity. 

Knowing the volume of the surface runoff within the study area will enhance the knowledge on 

the amount that can be harvested hence an indication of its ability to meet the demand gap that is 

currently experienced in Nairobi city. This will also act as a benchmark and an indication of the 

amount of deficit that will still exist after project completion. Knowing the shortage will help in 

planning strategies on other potential sources that can fill the gap. 

The estimation of runoff volume can also act as an informational tool and assist in flood control, 

land use planning, locating suitable water storage structures, drainage systems design and for 

warning purposes in case of hazards. 

1.5  Scope of work 

Since the three rivers that NCT project is focused on are known to be falling within the same 

watershed, this research focused first at delineating the watershed. The watershed boundary 

generated was then treated as the extent of interest where all the analysis is done. SCS-CN method 

was used as the method to determine the runoff volume that occurs from precipitation. To achieve 

this, land use and land cover classification was done and HSG generated from the soil classes. CN 

grid was then generated using hydrological modelling software available as an extension in 

ArcGIS software. Runoff was then calculated using daily precipitation data recorded in the nearest 

weather station. 
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Runoff was determined for four epochs (years; 2000, 2003, 2010 and 2015). All these epochs had 

different amount of rainfall ranging from high to low levels. This was intended to establish the 

fluctuations that are likely to occur in the amount of flood waters that are likely to be harvested 

within the watershed. To achieve this, land use/cover classification was performed for all the 

epochs. This was necessary because changes in land use has a significant impact on the runoff. 

The research considered only the major watershed formed by the three rivers focused in the NCT 

project to determine the combined flood waters contributed by the combined sub watersheds at the 

pour point. The confluence of the three rivers was treated as the pour point where the flood waters 

from the three rivers exit the watershed. This is the point where the runoff volume was determined.  

The approach differs from the existing situation in the NCT project being implemented because 

the project utilises intakes at each river and uses tunnels to allow the water flow by gravity from 

one river to the next river intake. This implies that the project abstracts water from the sub 

watersheds rather than the major watershed. The major watershed was chosen for this research 

because it reflects on the wholistic nature of the water to be harvested and easy comprehension 

when treated as one. Also, due to their small areal coverage, the sub watersheds could require high 

resolution data which was out of reach. Lastly, the volume available for validation of the results is 

a combined value of the three rivers without statement on value for each river. 

The research however does not in any way dwell on the location or design of the collector tunnel. 

It only determines the potential yield in terms of flood waters. It does not also estimate the potential 

volume of each river other than the combined volume which results after the three rivers have 

joined together. 

1.6 Organization of the Report 

The report has five chapters and a list of appendices. Chapter one provides an overview of the area 

of study by providing some background information. It also states the gaps to be filled under the 

problem statement including overall and specific objectives. The justification and scope of work 

is also dealt with under this section of the report.  

Chapter two covers the literature reviewed during the research process. It considers the runoff 

formation process and explains different factors that determine rate of water runoff. It also explains 

different methods of determining surface runoff. 
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Chapter three presents the materials and methods of the research. The area focused by the study is 

first depicted geographically and explained vividly. The materials are explained in terms of the 

data and software that were used. The methodology is then summarised in a flow chart then 

explained logically starting from the respective datasets and the analyses performed on them until 

final runoff depth is arrived at. The conversion of the runoff depth into runoff volume is also 

explained. 

Chapter four delivers the results of the research and discusses them. The results are explained in 

terms of the findings on the factors that were considered including the watershed, the soil map, 

land use/cover maps and statistics, curve number maps, runoff depth, runoff volume and validation 

of the findings. All these findings are discoursed under the discussion section. 

Chapter five has two sections. The first section is the conclusive remarks of the research and the 

second being the recommendations on areas that were perceived to be better fostered through 

research. 

  



 7 
 

CHAPTER 2: LITERATURE REVIEW 

2.1 Rainwater runoff 

This refers to the gravitational flow of a portion of precipitation on or below the surface of the 

earth (Rientjes, 2004). This occurs ideally within a watershed, which is an area draining water 

through a single exit point known as the pour point. The final amount of water available for runoff 

is determined by the surface and subsurface loses that occur to the level of reaching water balance 

state for the excess amount to occur as runoff (Mishra & Singh, 2003). These water flow and 

accumulates within the lowest points of the channel which act as flow paths to drain away as 

stream flows or rivers. 

Runoff is directly affected by the rainfall amount, ground permeability, vegetation covers and 

slope of the surface. Some human activities over time have also been found to increase runoff. 

Some of these activities include urbanization and large infrastructure networks. These human 

practices increase the percentage of impervious surface which discourages percolation hence 

forcing most precipitation water to flow straight away into streams or drains. 

The increasing amount of water runoff has led to increase in the negative impacts that accompany 

them. They include soil erosion and deposition, pollution of water and soil, loss of agricultural 

chemicals like fertilizers and floods in the downstream (Ward & Robinson, 1990). This has 

necessitated impose on mitigation measures which to some extent are expensive. The measures 

can be in many forms ranging from flood controls to land use planning and control. They are all 

aimed at minimizing the hazards which might occur (Morgan, 1995). 

2.2 Surface runoff in a watershed 

This stands for the part of rain water that is retained after interception loss, infiltration, 

evapotranspiration and surface storage. This water then flows to a stream through the earth’s 

surface (Morgan, 1995). Vegetation canopy intercept some of the falling rain and what remains 

thereafter falls onto the ground surface as through fall (White, 1997). The intercepted rainwater 

may either evaporate or drop to the ground if rainfall proceeding is heavy and continuous. Leaf 

drainage and stem flow can also occur because of canopy storage capacity being exceed. This is a 

clear indication that the vegetation cover together with rainfall trend of a place in a way determines 

the quantity of rainwater losses (Dingman, 2002). The water lost in this process is known as 

interception loss. 
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The precipitation drops that touches the soil surface can either penetrate, evapo-transpire or 

become stored in depressions within the ground surface. What remains after all this becomes the 

surface runoff. It is a common occurrence after the soil saturation is achieved. After surface storage 

becoming full and precipitation rate being higher than infiltration rate, gravitational flow of water 

occurs (Morgan, 1995; Ward & Robinson, 1990; Mishra & Singh, 2003). Sometimes the soil might 

be already saturated by previous storms hence most of the precipitation becomes runoff. 

2.3 Properties of soil influencing infiltration 

This explains the rate of water absorption by the soil after downpour. This generally act as a way 

of ground recharge and in the process determining water availability for runoff (Schwab, et al., 

1981; Morgan, 1995). Several properties of the soil including soil porosity, texture, structure of 

the soil aggregates, organic matter content, and moisture holding capacity (Solomon, 2005; 

Morgan, 1995) come into play to determine infiltration status. 

For water to flow through the soil, its porosity acts as the determining factor together with related 

aspects like particle size and aggregates arrangement (Dunne & Leopold, 1978). The geology and 

areas landforms contribute to the soil structure of a place (Hillel, 1980). Manmade activities aimed 

at better management of a watershed can as well influence the soil properties (Brady & Weil, 1996; 

White, 1997). 

The determining factor for soil to be able to allow water down its profile through infiltration is 

called hydraulic conductivity (White, 1997). Forces responsible for the process are suction and 

gravitational head gradient.  Suction is important at start of rain when the soil is dry while the later 

force comes into play after the soil becoming saturated with water. Saturated hydraulic 

conductivity will occur when the rainfall amount exceeds the rate of soil absorption hence causing 

ponding. Any water added to the soil will exceed capacity of storage hence resulting in surface 

runoff (White, 1997; Hillel, 1980). 

Saturated soil hydraulic conductivity varies with soil types. Soils rich in clay content tend to have 

less values than course texture soil such as sand. This make clayey have lower infiltration rate of 

up to 5mm/h compared to coarse textured soils like sand which will have 200mm/h (Morgan, 

1995). Compact soil will have lower conductivity when compared with loose soils (Hillel, 1980). 
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2.4 Land Use and Land Cover Changes in relation to surface Runoff 

Human developments and vegetation cover influence the processes through which rain water pass 

through before encountering the soil surface. These processes obviously lead to a series of water 

loses until a water balance state is achieved for runoff of excess water to take place. In this way, 

significant changes are taking place in the rate at which runoff is generated and these changes 

mostly lead to increased runoff which in the process leads to increased soil erosion and land 

degradation (Morgan, 1995). 

Soil compaction alters the soil profile by distracting the arrangement of components such as 

particles and aggregates (Schwab, et al., 1981). It also makes the soils tightly packed thus lowering 

the infiltration rate and leads to generally a different structure from what existed (Hillel, 1980). 

Such human practices are believed to drive the dynamism in the rate at which runoff volumes of 

developing areas is changing rapidly and causing unexpected hazards such as floods in some 

rapidly developing places (Dijck, 2000; Hillel, 1980). 

The vegetation act as a blanket that covers the soil and prevents it from exposure and in the process, 

enhances infiltration of water into the soil. Negative changes in land use/cover leaves the soil 

uncovered hence increasing susceptibility to detachment when heavy precipitation fall due to 

direct contact (Hillel, 1980; White, 1997). In the process, flowing water cause clogging of finer 

particles pore spaces of the soil creating thin compact layer preventing infiltration of water into 

the soil (Schwab, et al., 1981). This eventually leads to increased water runoff on the surface. 

Vegetation therefore is well known for reducing flow velocity of water hence reducing impact it 

causes on the soil. The soil structure is there for preserved due to less impact. Plant roots and dead 

leaves further strengthens the soil particles by holding them together. This leads to hardening of 

the soil structure thus inhibiting infiltration of water into the soil (Schwab, et al., 1981). This will 

lead to increased surface runoff. 

2.5 Runoff modelling 

There are several methods that has been devised to quantify runoff (Beven, 2000; Dingman, 2002). 

The most common approach being gauging a stream canal then measuring its water flow pattern 

over time. This method however does not take into consideration variation in land management 

practices such as LULC changes and soil on the magnitude at which runoff is created from diverse 

areas in a watershed. Because of the significant influence of dynamics in the catchment in terms 
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of spatial and temporal heterogeneity, an ideal method should consider them during quantification 

process. 

Mathematical formulas are widely used to model the real process of runoff under normal 

circumstances. This makes other models to be more precise when compared with others. Each 

model usually has the factors under consideration described mathematically in a form that can 

make quantifiable predictions (Beven, 2000; Rientjes, 2004). The factors involved vary widely 

over small distances. It is never possible to consider all factors at all instances due to the variations 

but instead, the mean of values showing similarity is utilized. This is a clear indication of one of 

the many assumptions that are involved in these models whether empirical, physical or both 

(Beven, 2000). 

Physical models are hard to accomplish because most of the parameters are achieved through 

measurement or observation. This implies that the process is prone to errors and blunders due to 

limitation of the investigator, instrument or environmental factors (Deursen, 1995; Pfeffer, 2003). 

The errors introduced will finally contribute to the overall inaccuracy of the model hence limiting 

its reliability (Deursen, 1995). Simple empirical models on the other hand tend to be more general. 

This often leads to omission of some information (Beven, 2000). The two explanations justify that 

there is no single precise model that can fully accommodate all factors involved in nature to reflect 

the actual natural process of runoff. 

For better result to be achieved, it should first start with identifying the problem at hand. Then 

recognition of the nature of the watershed should follow. Finally, simulate surface runoff while 

taking into consideration changes in LULC (Ward & Robinson, 1990; Deursen, 1995; Beven, 

2000). This process can give better forecast by detecting areas which contribute more runoff. The 

information can be a valuable resource when planning for better catchment management practices. 

The choice of a suitable model will majorly be driven by the target of a research and other factors 

like accessibility of data, time and money. 

2.6 Types of Runoff Models 

They are broadly categorised into two classes namely lumped/ distributed and deterministic/ 

stochastic models (Ward & Robinson, 1990; Beven, 2000). 
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The lumped modelling methods consider a watershed as an individual unit with only one mean 

value representing it entirely and generates unique forecast values (Beven, 2000). Distributed 

modelling approach make spatially distributed forecast where variables are visualized by varying 

or invariable grid cells carrying the averaged values unlike lumped method which uses only one 

averaged value (Rientjes, 2004). Each grid cell is applied the equation hence giving distinct results 

for each cell hence facilitating monitoring of factors affecting runoff that vary with space such as 

land use and land cover (Beven, 2000). 

Stochastic/probability models focus at the possibility of hydrologic variable occurring (Ward & 

Robinson, 1990). Its input and output variables are in form of probability density distribution. The 

possible outcome of this method is uncertain and random but this is allowable due to the risk that 

is presented by model input variables (Beven, 2000; Rientjes, 2004). 

Most runoff models utilize deterministic models which dwell on the imitation of the physical 

procedures taking place in the cycle that take place from precipitation to runoff. Only a single set 

of values are entered per variable into the model hence resulting into single set of values (Rientjes, 

2004). 

2.7 Soil Conservation Service-Curve Number (SCS-CN) Method 

The SCS-CN approach was utilized for the accomplishment of the research. This method entails 

the use of an equation to make estimates of runoff depth that occurs after precipitation. The 

equation is empirical based and was developed in United States through observations on rainfall 

runoff data collected from different regions over extended duration of time (Beven, 2000; Mishra 

& Singh, 2003; Shadeed & Almasri, 2010). The selection of this method for this study was arrived 

at due to the simplicity and less demands when it comes to data requirements. It is further boosted 

significantly by the accessibility of readily tabulated CN values (Appendix A) for a broad range 

of soil groups and land use/cover patterns which act as a guideline (Mishra & Singh, 2003).  

The approach looks at the time distribution of precipitation and the initial precipitation losses to 

interception by objects, surface storage in pools and soil infiltration rate that diminish over a period 

of a rainfall occurrence (Gerlach et al., 2003). Some amount of rainfall will not contribute to a 

runoff till all the demands of the initial abstraction (Ia) are met. Hence the potential runoff is given 

by (P-Ia). After water becoming available for a runoff, some extra amount of water remains in the 

drainage area which is less or equivalent to the potential maximum retention (S). 
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Equation 3-1 below summarizes how rainfall, initial abstraction, the potential maximum retention 

and the additional water retained are expressed mathematically. When this method is applied in an 

iterative environment, it will result in surface runoff values varying both with location and time 

(Deursen, 1995; Shadeed & Almasri, 2010). 

The universal equation of SCS-CN method (Mishra & Singh, 2003): 

𝑄 =
(𝑃−𝐼𝑎)2

(𝑃−𝐼𝑎+ 𝑆)
                                                                                                                           (2-1) 

Where; 

Q = runoff (inch) 

P = rainfall (inch) 

Ia = Initial abstraction (surface storage, interception, and infiltration, inch) 

S = potential maximum retention (inch) 

The Ia can further be expressed by the following empirical equation: 

𝐼𝑎 = 0.2 𝑆                                                                                                                                 ( 2-2) 

Substituting equation 3-2 into equation 3-1 gives: 

𝑄 =
(𝑃−0.2𝑆)2

(𝑃+0.8𝑆)
                                                                                                                             (2-3)   

P is a measurable quantity and can easily be obtained. However, S is hard to determine. As a result, 

the runoff curve number is used to establish S based on the following relationship: 

𝑆 =
1000

𝐶𝑁
− 10                                                                                                                            (2-4) 

Where; 

CN = runoff Curve Number 

Appendix A is the table with values where the CN is derived from basing on the soil condition, 

land use/cover, and treatment of an area. This is where it is referred to as localization of the 

variables to reflect an area being studied. The larger the CN value, the greater the runoff potential 
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and vice versa. The initial wetness of the soil, also known as AMC can also be put into 

consideration in this approach. Once the CN is identified based on land use/cover and the type of 

soil in an area, equation 3-5 below can then be used to adjust the CN values for moisture condition 

(AMC). 

𝐶𝑁𝑎𝑑𝑗 =
23𝐶𝑁

10+0.13𝐶𝑁
                                                                                                                     (2-5) 

This equation is used for a study in which the daily precipitation data is not available. 
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CHAPTER 3: MATERIALS AND METHODS 

3.1 Study Area 

3.1.1 Location and Description 

The research focuses on the Northern Collector Water Tunnel (NCT) project which is situated 

within Murang’a county in central Kenya. The county resides in a total area of 2,558.8Km2. NCT 

anticipates harnessing floodwater from three rivers shown in Figure 3.1 below, namely Maragua, 

Gikie, and Irati, which are within the same watershed with their source being Aberdare forest. The 

area extends between latitudes 0º33'30'' S and 1º5'20'' S, and longitudes 36º41'00'' E and 37º25'20'' 

E. Its proximity to Nairobi city and the fact that it has numerous rivers has made it to be recognized 

as the primary source of water to meet the rising demand. 

 

Figure 3.1: The Study Area 

The watershed being within the Aberdare ranges and proximal to Mount Kenya, experiences an 

equatorial type of climate making it wet and humid. The months of March, April, and May receive 

long rains while October and November receive short rains.  

The watershed falls approximately 3,353m Above Sea Level (ASL) and experience extremely 

dissected topography which is drained by numerous rivers flowing from the Aberdare ranges to 

join the great River Tana. The soils are mainly volcanic hence highly productive and significant 

for agricultural activities. This explains why tea is the main crop grown within the watershed. 
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3.2 Materials 

The materials used in the study are categorized into data and software. They are summarised in 

the following two subsections: 

3.2.1 Data 

The topographic map at the scale of 1:50000 prepared by Survey of Kenya (SoK) was utilized for 

delineation of rivers within the watershed and to digitize boundaries. The Landsat imagery with 

30m resolution downloaded from USGS website was used to prepare the land use/cover (LULC) 

map of the watershed. Soil map made through Kenya soil survey of 1987 on 1:50000 was utilized. 

30m resolution Aster DEM data was used to generate the slope and determining the extents of the 

watershed. 

Table 3.1: Data and their sources 

Type of Data Scale/Data Resolution Source of Data 

Rainfall Daily Nyeri Station Precipitation Kenya Meteorological Department 

Landsat data 30m (2000,2003,2010,2015) www.earthexplorer.usgs.gov 

Soil 1:250,000 ILRI (Kenya soil survey 1987) 

Toposheets 1:50,000 Survey of Kenya 

Aster DEM 30m DRSRS 

3.2.2 Software 

ArcGIS 10.4 software was utilized for creating, handling and generation of different layers and 

maps. ERDAS Imagine 2014 was utilized in generating LULC maps due to its better accuracy in 

land use/cover analysis compared to other GIS software. The Geospatial Hydrologic Modelling 

Extension (HEC-GeoHMS) for ArcGIS was used for hydrologic modelling.  Microsoft excel was 

utilized in mathematical computation of runoff depth from the daily rainfall data. 

The modelling approach that was used to model runoff is the Soil Conservation Service-Curve 

Number (SCS-CN) Method. The approach was selected because of its elementary nature in terms 

of data necessary and due to the element that it considers the impact of land use/cover dynamics 

while deriving the parameters (CN) used to compute excess precipitation. 

http://www.earthexplorer.usgs.gov/
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3.3 The Methodology 

The runoff was predicted with the help of hydrological model utilizing USDA (United States 

Department of Agriculture) procedure for estimation of surface runoff using SCS-CN (Soil 

Conservation Service Curve Number) method. Figure 3.2 below shows the methodology adopted;  

 

Figure 3.2: The methodology flow diagram 

SATELLITE DATA 

(Landsat) 

CLASSIFIED LAND USE / LAND COVER 

MAP 

ANTECEDENT 

MOISTURE CONDITION 

RAINFALL DATA 

HSG MAP 

SOIL DATA 

FILL 

CN Grid 

SOIL-VEGETATION-LAND USE 

COMPLEX (SVL) 

Modified Weighted CN 

Parameters for Modified SCS Model 

RUNOFF DEPTH ESTIMATE 

UNION 

ASTER DEM 

WATERSHED  

WATERSHED POLYGON 

FLOW ACCUMULATION 

FLOW DIRECTION 

Watershed polygon 

Land use-CN LookUP 

Table 

% Areas for each CN Grid 

CN Grid polygons 

CN for AMC I, AMC II, AMCIII 



 17 
 

3.3.1 Watershed Delineation 

The extraction watershed extent for the three rivers was done using ArcGIS 10.4 software. To 

accomplish this, ArcToolbox was opened from the main menu. Spatial Analysis Tools > Hydrology 

was expanded to view the important tools required for the process. First, the Fill hydrology tool 

was used to eliminate imperfection (sink) in the DEM. The DEM was specified as input and the 

fill layer as the output. Flow Direction tool was used to create grids representing flow direction 

within the cells. The filled DEM was used as the input and the output is the Flow Direction Raster. 

Flow Accumulation tool was then used to calculate the flow into each cell. Flow direction raster 

was specified as the input at this stage and flow accumulation raster as the output. The flow 

accumulation raster was reclassified into two classes, one with accumulation values less than 5000 

and another class with values greater than 5000. The values greater than 5000 represented the 

stream paths which form the river. The point where the three rivers under consideration exited was 

identified as the pour point of the watershed. A new point feature class representing the pour points 

was then created by right clicking the geodatabase and selecting New > Feature Class. Editor for 

the new feature class was started and the pour point digitized. The edits were saved and editing 

mode stopped. 

Snap Pour Point tool was used to establish the three sub-watersheds. Flow accumulation raster 

was specified as the input together with the pour points created and the resulting layer represents 

the watershed with defined pour pont. Finally, the watershed tool was clicked and specification of 

flow direction raster and feature pour point data as inputs and the output will be the raster 

representing the watershed. The watershed raster created was then converted to polygons using the 

tool from ArcToolbox > Conversion > From Raster. 

3.3.2 Preparation of Various Thematic Maps 

The different thematic maps that were prepared using ERDAS Imagine 2013 and Arc GIS 10.4 are 

the soil map, land use/cover classification maps and the curve number maps. 

3.3.3 Soil Map 

SCS developed soil classification system that consists of four groups, which are identified as A, 

B, C, and D according to their lowest infiltration rate. Group A: Soil having high penetration rate 

and low runoff potential when thoroughly wet. Water is conveyed freely through the soil; Group 

B: Soil having moderately moderate infiltration rate and low runoff potential when thoroughly 



 18 
 

wet. Water conveyance through the soil is medium; Group C: Soil having low penetration rate and 

moderately high runoff potential when thoroughly wet. Conveyance of water is somewhat 

restricted through the soil; Group D: Soil having very low infiltration rate and a bit high runoff 

potential when thoroughly wet. Water conveyance is limited through the soil. 

Based on (Mishra & Singh, 2003), the soil was categorized into their respective HSG as shown in 

Table 3.2 while considering texture, percentage slope and infiltration rate (IR) of the soil. A field 

was added in the soil attribute table and the respective hydrological groups keyed in. 

Table 3.2: The Hydrological Soil Group Classes within the study area 

Texture Class %Slope IR (Inches/Hour) HSG 

Clay Over 16% 0.03 D 

Clay Loam Over 16% 0.06 C 

Sand Clay Over 16% 0.08 C 

Silty Clay Over 16% 0.05 D 

Because the Curve numbers are assigned by HEC-GeoHMS ArcGIS extension which uses lookup 

table to perform computations, four additional fields required to normalise the respective HSG 

were added as percentages. The fields were labelled PctA, PctB, PctC and PctD standing for 

abbreviations to the percentages of the soil groups. A value 100 is assigned where CN field value 

coincides with percentage values for example C and PctC or D and PctD. All other fields are 

assigned a value of zero. The fields were useful when assigning Curve Numbers with the help of 

lookup tables during computations. 

3.3.4 Land Use Land Cover (LULC) Classification 

Land use/cover classification was done using unsupervised classification method by use of four 

classes namely Forest, Agriculture, Built up areas and Shrubs/Rock. This method of classification 

was chosen due to its unique ability to distinguish clearly and precisely all reflectance values 

contained in a multispectral imagery. Each image was classified separately by use of Erdas 

Imagine software as follows: 

All the Landsat images were first layer stacked using the tool found under Raster > Spectral > 

Layer Stack option. All the bands were added independently as input files after choosing ‘.Tiff’ 
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format under the files of type option. Output location for the resulting multispectral imagery was 

then specified and union function was chosen. This was repeated for all the epochs.  

The multispectral imagery was then loaded to the viewer window by right clicking on viewer and 

choosing open raster layer then browse to directory and opening it. The watershed shapefile was 

also loaded in the same window through the same process as for the multispectral imagery but 

choosing the Open Vector Layer option instead. Select tool from Raster > Select was then used to 

highlight the shapefile then the selection was copied and pasted to Aoi (Area of interest) using 

Copy and Paste option available under the Home tab. The Aoi was then saved by right clicking it 

in the contents menu and choosing save as Aoi option. 

Subseting of the layer stacked images was then done using the tool found under Raster > Subset 

& Chip > Create Subset Image. Multispectral images from the layer stack was chosen as input. 

Output location was specified and Aoi created specified as the extent. This step was repeated for 

all the four epochs under consideration in the study. 

The classification of the year 2000 Landsat imagery started with the launch of Raster > 

Unsupervised > Unsupervised Classification tool from the main menu. The subset for year 2000 

was chosen as Input Raster File and the resulting classified raster layer saved the output. K means 

method of classification with eight classes was used for this epoch. The eight classes were later 

recoded into four classes using Raster>Thematic>Recode tool. The recoded image was later 

smoothened using neighbourhood tool from Raster>Thematic>Neighbourhood using majority 

pixels and 3x3 window size. 

Classification for the years 2003, 2010 and 2015 was performed similarly as explained above (in 

year 2000 classification) but the number of classes generated through unsupervised classification 

vary. Nine classes were generated for the year 2003, sixteen classes for the year 2010 and seven 

classes for 2015. The choice of the number of classes was based on complexity of the reflectance 

of the respective images. Recoding was done on all images to achieve the required four classes 

that had been identified for this study. The recoded images were also smoothened using a majority 

pixels 3x3 window size. The statistics of land use and land cover were extracted from the raster 

attribute tables of respective classified and recoded images. 
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Accuracy assessment was then performed using ten random points per class. Google earth aerial 

images was used as ground truth data during the accuracy assessment. 

3.3.5 Soil-Vegetation-Land Use (SVL) complex  

This refers to the layer resulting from the overlay of LULC and HSG maps through a spatial Union. 

To achieve this, the LULC maps were first converted from raster to polygons in ArcGIS software 

using Raster to Polygon tool found in ArcToolbox>Conversion Tools>From Raster>Raster to 

Polygon. The input being the recoded images while the output being the resulting polygons. A new 

field was added in the land use attribute table then each land use was assigned unique Land use 

code in form of values ranging from one to four. These values would be required in HEC-GeoHMS 

processing. 

LULC polygons and HSG were joined through ArcGIS spatial analyst Union tool found under 

Geoprocessing tools. Land Use and Soil layers were selected as inputs and the output being the 

union of the two layers. All polygons which did not overlay appeared with negative geometry in 

the attribute table and were deleted. The land use and HSG attributes will be mutually available 

for every polygon within the study area after the union of the two layers. 

3.3.6 Generating Curve Number (CN) Grid 

HEC-GeoHMS extension of ArcGIS was utilized at this stage since it involves hydrological 

modelling. To generate the CN map, the fill DEM, SVL complex and CNLookUp table are 

required as input datasets. The curve numbers for different cover classes and respective 

hydrological soil groups (Table 3.3) are pre-defined based on (Mishra & Singh, 2003) as shown in 

Appendix A. The CNLookUp table for this case is a table representing the AMC II values in 

different HSG as shown in Table 3.4 below. It works by creating a new raster by looking up values 

found in another field in the table of the input layer. For this case, the SVL complex polygon layer 

with land use number one and HSG D will be assigned a CN of 96 while a polygon of land use 

number four with the same HSG will be assigned a CN of 89. 
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Table 3.3: Runoff curve numbers for hydrologic cover complexes (AMC II and Ia=0.02S) 

(Mishra & Singh, 2003) 

Class Land use Description/treatment Hydrologic 

Condition/% 

impervious area 

Hydrologic Soil 

Groups  

A B C D 

Shrubs and 

Rocks 

Arid and Semiarid rangelands: Herbaceous Poor 
 

80 87 93 

Forest Humid rangelands or agricultural uncultivated 

lands: Woods or forest land 

Poor 45 66 77 83 

Built-up Developing areas: Newly graded areas (pervious areas only, no 

vegetation) 

77 86 91 94 

Agricultural Row crops: Contoured  Good 65 75 82 86 

Table 3.4: The LookUp table used to assign the AMC II CN to SVL complex 

LULC HSG 

LUValue Description A B C D 

1 Shrubs/Rock 
 

80 87 93 

2 Forest 45 66 77 83 

3 Built-up 77 86 91 94 

4 Agriculture 65 75 82 86 

From HEC-GeoHMS toolbar in ArcGIS, go to Utility>Generate CN Grid then a dialog box was 

launched prompting for inputs and output location. Specify fill DEM, SVL and CNLookUp table 

respectively as input and browse to where to save the CN grid and name it then save as illustrated 

in Figure 3.3. The soil map and land use map were selected for a union. A map with new polygons 

representing the SVL complex map resulted. The corresponding CN values for each polygon of 

the complex map were then assigned. 

 

Figure 3.3: Screenshot of the tool for generating CN Grid 
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Hilly areas are significant in terms of rainfall-runoff response. The rapid runoff response from 

steep slopes results in non-availability of water in peak demand periods, even if the average rainfall 

is high. For this reason, fill was derived from the DEM, which is the sink free DEM considered to 

be free from imperfections. This fill is important in the process of generating CN values because 

it played a significant role in determining the runoff direction and accumulation. 

3.3.7 Preparations of CN Grid for Runoff Estimation 

a) CN Grid polygons 

The raster CN Grids generated were first converted to polygons to determine the total areas 

covered by specific CN. The areas are required to be used when calculating the weights. 

b) Percentage areas for each CN Grid 

At this stage, the areas obtained for the various CN are converted into a fraction of the total area 

of the watershed. This is equivalent to assigning a weight to each CN based on the total area it 

covers. 

c) Modified Weighted Curve Number (CN) 

All the percentage areas are multiplied by their curve number and divided by 100. The products of 

all the areas are added to give one overall weight representing the entire watershed. This is the 

modified weighted curve number that stands as the Mean CN representing entire watershed. 

d) Assigning of AMC I and AMC III CN to weighted AMC II CN (in c) above  

Since the weighted curve number value obtained was for AMC II, the other two AMC values were 

assigned from the table of AMC shown in Appendix B. 

3.3.8 The Rainfall Data 

In this research work, daily precipitation data documented over time in a weather station within 

vicinity from the watershed was used. Daily rainfall data was chosen because the AMC of the soil 

can only be computed using total precipitation for five successive days preceding a storm. The 

data was readily available in excel sheet hence making the computations easier. 
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3.3.9 Antecedent Moisture Conditions (AMC) 

The Antecedent Moisture Condition (AMC) is simply the water content present in the soil at a 

specific time. It is the crucial effect on the flow responses in these systems during wet weather.   

It was determined by summing the total rainfall recorded in five consecutive days before a storm. 

The AMC value is envisioned to imitate the consequence of infiltration on both the rate of runoff 

and volume according to the infiltration curve. An increase in the index means an increase in the 

runoff potential. The SCS established three antecedent soil-moisture conditions and categorized 

them as I, II, III, according to rainfall limits and soil conditions for dormant and growing seasons 

as shown in Table 3.5 below. This technique was helpful in rectifying the influence of soil moisture 

on the runoff potential of the area. It is also important to note that a greater percentage of the 

watershed was covered with forest and tea plantations hence for this reason, a growing season was 

assumed in the study.  

Table 3.5: AMC for determination of CN value (Mishra & Singh, 2003) 

AMC Total Rain in Previous 5 days 

Dormant Season Growing Season 

I Less than 13 mm Less than 36 mm 

II 13 to 28 mm 36 to 53 mm 

III More than 28 mm More than 53 mm 
 

3.3.10 Estimation of Runoff Depth Using parameters for SCS Model 

The runoff was calculated using rainfall data from Kenya Meteorological Department. The SCS 

Model also known as the Hydrologic Soil Cover Complex (HSCC) Model, is a useful and 

extensively used process for estimation of runoff. The model utilizes runoff producing capability 

expressed by a numerical value (Curve Number) varying between 0-100. This model was utilized 

in the study. 

To materialize this, CNs were first assigned based on computed AMC that represents five-day 

precipitation. Potential maximum retention (S) was then computed using the equation (2-4). 

Subsequently, initial abstraction (surface storage, interception, and infiltration) was computed 

using equation (2-2). For all values with precipitation greater than the initial abstraction (Ia), the 

runoff depth was computed using equation (2-3) (Mishra & Singh, 2003). The result was daily 

runoff depth for all the specific days of the year. 
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3.3.11 Calculating the Runoff Volume 

To convert the computed runoff depth into runoff volume, the units of the depth and watershed 

area were first harmonised. Thereafter, the area of the watershed was multiplied with the obtained 

runoff depth to give the resultant volume of excess water that will pass through the pour point of 

the watershed after precipitation (Bedient & Huber, 1992).  
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CHAPTER 4: RESULTS AND DISCUSSIONS 

4.1 Results 

4.1.1 The Watershed 

The total area of the watershed was found stretch approximately 208.3 square kilometers with its 

starting point at the peak of Aberdare ranges and the pour point of the three rivers being around 

Kigumo market within Murang’a County. The watershed has three major Sub watersheds in which 

the collector tunnel will be abstracting water from them. Figure 4.1 shows the watershed, rivers 

and the collector tunnel. 

 

Figure 4.1: The Watershed and the Location of the Collector Tunnel 

4.1.2 The soil Map 

Clay soil of types montmorillonitic and kaolinitic were found to dominate the watershed as shown 

in Figure 4.2 below. Kaolinitic soil majorly concentrated on the lower parts of the watershed and 

comprised of types clay and silt clay textured soil falling under HSG D. Montmorillonitic soil were 

found to dominate the upper parts where the watershed starts and comprises of clay loam and sand 

clay textured soil falling under HSG C. 
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Figure 4.2: Hydrological Soil Group (HSG) Map with an Inset showing the Soil Texture Classes 

4.1.3 Land use Land Cover Maps 

The Overall Classification Accuracy of classification for the years 2000, 2003, 2010 and 2015 was 

found to be 87.5%, 97.5%, 90.0% and 87.5% respectively. Both the producer and user accuracies 

was also found to be greater than 70% in all the years. The user accuracies for the years 2000 and 

2010 was slightly low because of limited clouds and cloud shadows that were obstructing some 

areas. These clouds remained after attempts to eliminate them however they were manually 

reclassified during classification with the help of ground truth data. Accuracies over 70% implies 

that the LULC results are reliable and reflect what is on the ground and the changes that occurred 

over time. Appendix C shows the accuracy assessment results for the different years. 

The maps in Figure 4.3 and Figure 4.4 show the results of LULC that were obtained for the 

watershed over the four epochs that were studied. 
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Figure 4.3: LULC maps for the years 2000 and 2003 

 

Figure 4.4: LULC maps for the years 2010 and 2015 
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The statistics of LULC results were derived and tabulated as shown in Table 4.1. Since the Landsat 

data used to perform LULC classification was 30m resolution, the total area of the classified 

images varied a bit due to discrepancies encountered at the edges during masking of the images to 

obtain only the parts covering the watershed.  

Table 4.1: Statistics of LULC results for different years 

Land Cover Types Area (Hectares) 
 

2000 2003 2010 2015 

Shrubs and Rock 2639.34 2306.09 2423.16 2643.05 

Forest 8530.38 7941.06 8228.7 6220.71 

Built-up 2416.68 2984.71 3023.64 3777.14 

Agriculture 7389.54 7678.15 7306.47 8269.11 

Total 20975.94 20910.01 20981.97 20910.01 

The chart in Figure 4.5 below visually conveys the results in Table 4.1. 

 

Figure 4.5: Chart showing Areas occupied by various classes in different years 

Shrubs and rocks were found to occupy the least area within the watershed. Since the watershed is 

within the slopes of Aberdare ranges which is characterised by ridges and valleys, the alternating 

Shrubs and rocky vegetation are found mainly along the ridges and at the peak. Their coverage 

was found to be less variant over the period of study. Their areal coverage remained almost the 

same over the entire duration despite small variation which might have been caused by their 

responses to changes in weather conditions because images of different months were used to 
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perform analysis. Also, these vegetation falls mostly within Aberdare forest which is a protected 

area meaning limited interferences. 

Forest was found to be decreasing in size over time. There were limited changes within the 

conserved parts of Aberdare forest however most dynamics were occurring within the settlement 

areas where forested land was being cleared and converted into agricultural land as evidenced by 

the inverse trend of agriculture when compared with the trend of forest. The trend anomaly in the 

year 2010 might be due to the presence of clouds in the image that was used. Despite the clouds 

being masked and manually classified, some error residue might have remained which explains 

the irregularity. Forest is occupying the largest area compared to other classes however agricultural 

land is increasing and might dominate soon if this trend persists. 

Built-up area is increasing steadily though at a slower rate. Some of the cleared forest and 

agricultural land might have been converted into settlement areas. This is what might have resulted 

into increase in the built-up areas. Some of the bare lands especially cultivated land was found to 

be classified as built-up areas despite attempts to separate. This was made difficult by the fact that 

the two classes had almost similar reflectance. 

Agricultural land is generally increasing over the years with 2015 recording the highest area of 

land under agriculture. The trend of changes in agricultural land is gradual due to the challenge of 

correctly representing different types of land under different crops which are at different stages of 

growth. To overcome this complexity and minimise the struggle of trying to classify agriculture 

types, unsupervised classification with more classes was performed then the classes were recoded 

into four classes. 
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4.1.4 The Curve Number Maps 

Since the watershed had two HSG and four LULC classes were considered in the study, eight curve 

numbers were derived as shown in the CN maps in Figure 4.6 and Figure 4.7.  

 

Figure 4.6: The Curve Number map of different SVL complexes for the years 2000 and 2003 

 

Figure 4.7: The Curve Number map of different SVL complexes for the years 2010 and 2015 



 31 
 

The CNs represent land use/cover classes falling in both hydrological groups for example, forest 

falling in HSG C will have a CN value of 77 while the same forest falling in HSG D will also have 

a curve number value of 83 as specified in Table 3.3. Similarly, all other classes will have two 

values under the two HSG. This makes the four classes generate a total of eight CN values each 

representing unique SVL complex as shown in Table 4.2. The area of each SVL complex is 

determined because the percentage coverage is required to be used to calculate the overall weighted 

Curve Number. 

Table 4.2: The SVL complex of the watershed for the various years 

 

SVL 

Complex 

 

CN (For 

AMC II) 

2000 2003 2010 2015 

Area 

(Hectares) 

% 

Area 

Area 

(Hectares) 

% 

Area 

Area 

(Hectares) 

% 

Area 

Area 

(Hectares) 

% 

Area 

1 77 5219.6 25.0 5980.1 28.7 6574.7 31.5 4624.2 22.2 

2 82 3076.0 14.8 2771.7 13.3 2268.1 10.9 3140.0 15.1 

3 83 3257.7 15.6 1953.3 9.4 1615.3 7.8 1553.5 7.5 

4 86 4346.4 20.9 4931.4 23.7 5063.3 24.3 5155.0 24.7 

5 87 2556.4 12.3 2031.9 9.7 1849.0 8.9 2568.0 12.3 

6 91 1376.3 6.6 1445.9 6.9 1537.0 7.4 1897.4 9.1 

7 93 52.8 0.3 245.5 1.2 509.8 2.4 56.5 0.3 

8 94 953.4 4.6 1481.0 7.1 1422.1 6.8 1846.3 8.9 

Total 20838.7 100.0 20840.9 100.0 20839.2 100.0 20840.9 100.0 

The above tabulated results can be visually represented as shown in Figure 4.8. The chart 

summarises the statistics of variability of specific SVL complex over the four epochs focused in 

the study. It is clearly evident that as the percentage area coverage increases for most complexes 

while others decrease despite some small fluctuations. 
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Figure 4.8: Chart showing the percentage area distribution of SVL complex CN for different 

epochs 

The percentage areas of the different SVL complexes were then used to weight the CN for the 

various SVL complexes. The intention was to obtain one weighted CN representing entire 

watershed uniquely. Table 4.3 summarises the process of obtaining the weighted CN. 

Table 4.3: Table showing the computation of the Weighted Curve Number for all the four epochs 

SVL 

Complex 

CN (for 

AMC 

II) 

2000 2003 2010 2015 

% Area Weighted_CN 

(AMC II) 

% 

Area 

Weighted_CN 

(AMC II) 

% 

Area 

Weighted_CN 

(AMC II) 

% 

Area 

Weighted_CN 

(AMC II) 

1 77 25.05 19.29 28.69 22.09 31.55 24.29 22.19 17.08 

2 82 14.76 12.10 13.30 10.91 10.88 8.92 15.07 12.35 

3 83 15.63 12.98 9.37 7.78 7.75 6.43 7.45 6.19 

4 86 20.86 17.94 23.66 20.35 24.30 20.90 24.74 21.27 

5 87 12.27 10.67 9.75 8.48 8.87 7.72 12.32 10.72 

6 91 6.60 6.01 6.94 6.31 7.38 6.71 9.10 8.28 

7 93 0.25 0.24 1.18 1.10 2.45 2.27 0.27 0.25 

8 94 4.58 4.30 7.11 6.68 6.82 6.41 8.86 8.33 

SUM 100.00 83.52 100.00 83.70 100.00 83.67 100.00 84.48 

Rounding Off W_CN ≈84 W_CN ≈84 W_CN ≈84 W_CN ≈84 
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From the sum of the overall weighted CN shown in Table 4.3 above, before rounding off the 

weighted value, it is evident that the weighted CN is increasing gradually from the year 2000 as 

illustrated in Figure 4.9. The weighted Curve Number was found to increase through small values 

that when rounded off remains to be 84 for all the epochs.  The reason for round off is to obtain a 

significant definite weighted CN that can be used to extract AMC I and AMC III from the table in 

Appendix B.  

 

Figure 4.9: The graph showing the trend of Curve Numbers before Round off 

Although small increase in the value of the annual weighted curve numbers before round off is 

evident, a constant value of 84 for all the epochs after round off implies that only negligible 

changes can occur in the watershed within a period of 15 years that was considered in the study. 

As far as the CN values are increasing at a slower rate, runoff will also be increasing at an 

equivalent rate. But since the final rounded off value is equal for all the epochs, it implies that 

runoff was not affected significantly by the changes that occurred in the watershed within the 

duration considered. 

The rounded off Weighted CN (AMC II) values in Table 4.3 for all the four epochs were then 

assigned respective AMC I and AMC II values using the table in Appendix B. The final weighted 

AMC values in Table 4.4 were obtained. 
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Table 4.4: The Weighted AMC value for the four epochs 

YEAR AMC II AMC I AMC III 

2000 84 68 93 

2003 84 68 93 

2010 84 68 93 

2015 84 68 93 

 

4.1.5 Runoff Depth 

Table 4.5 summarises the runoff depth (Q) values that were obtained after the calculations. It is 

evident that the average rainfall of the area is approximately 1100mm per year which results in a 

runoff depth of slightly over 200mm. This implies that approximately 20% of the precipitation is 

converted into runoff. Precipitation that is less than 1000mm like for the year 2000 was found to 

contribute the least runoff amounting to 6.07% of the total precipitation. 

Table 4.5: The Summary of Runoff Depth Results 

Year Days with 

Runoff 

Precipitation 

(P_mm) 

Runoff 

(Q_mm) 

Runoff Volume 

(M3) 

% of water turned 

into Runoff 

2000 9 562.61 34.17 7120686.458 6.07 

2003 26 1386.59 458.89 95632370.51 33.09 

2010 29 1171.96 230.00 47931004.59 19.62 

2015 32 1161.03 200.81 41848719.13 17.30 

 

4.1.6 Runoff Volume 

Runoff volumes of 7120686.458M3, 95632370.51 M3, 47931004.59 M3 and 41848719.13M3 were 

obtained for the years 2000, 2003, 2010 and 2015 respectively as summarised in Table 4.5. The 

runoff volume is directly proportional to the amount of precipitation received (Figure 3.1). The 

number of days annually with runoff can be less but contribute more runoff volume as evident in 

the year 2003. 
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4.1.7 Validation of the Results 

The findings were validated by comparing the values obtained with the river depth analysis result 

that was obtained during the research conducted at the feasibility study stage of the NCT project. 

The average runoff volume obtained from the days that were found to contribute runoff from all 

the four epochs was found to agree with the NCT daily runoff estimate results for the phase one 

project. Table 4.6 shows the computed daily runoff based on the number of days that were found 

to contribute runoff and the documented NCT daily runoff values in the commissioning booklet 

for the phase one of the project. 

Table 4.6: Comparison between the study findings and NCT values 

STUDY FINDINGS 
VALIDATION 

VALUE 

Year Days with Runoff 

(Days/Year) 

Runoff Volume 

(M3/Year) 

Daily Runoff 

(M3/Day) 

NCT Daily Runoff 

(M3/Day) 

2000 9 7120686.46 791187.38  

1,198,368 

(43% to be 

abstracted: 513,388) 

2003 26 95632370.51 3678168.10 

2010 29 47931004.59 1652793.26 

2015 32 41848719.13 1307772.47 

 

4.2 Discussion of the Results 

The three rivers contributing water to the collector tunnel were found to lie within one watershed 

with an area of approximately 208.3 square kilometres. The tunnel cuts across the watershed 

tapping water from all the rivers through intakes as shown in Figure 4.1. The flood water will be 

abstracted from the sub watershed before they reach the pour point of the major watershed. 

From Figure 4.2, two HSG namely C and D were found to dominate the watershed. The soils at 

the northern part of the watershed were found to be of HSG C meaning they have highest runoff 

potential in the watershed. This is because it lies at the peak of Aberdare where rocks and mountain 

vegetation dominate hence limiting infiltration and favouring runoff. The southern parts of the 

watershed were found to be dominated by HSG D which has low runoff potential. This is majorly 

due to presence of agricultural lands in this section. The crops require more water hence increasing 

the rate of infiltration which in turn leads to lower runoff potential. 
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Land use/cover changes within the watershed were found to be minimal within the period of fifteen 

years that was considered in the study as shown in Table 4.1 and Figure 4.5 . This was clearly 

evident especially with land uses that cause significant changes in runoff such us built-up areas 

and shrubs and rocks. The impact of these insignificant changes is reflected directly in the CN 

values which determine runoff potential. Figure 4.9 shows the trend of the weighted CN that was 

obtained from the four epochs that were studied. It is apparent that the weighted CN is increasing 

with time. However, the rate at which it is increasing is very low, from 83.52 in the year 2000 to 

84.48 in the year 2015 (Table 4.3). When these values are rounded off, they become a weighted 

CN value of 84 implying that the change is so small to create a difference. This confirms that the 

land use/cover changes in the area has little impact on surface runoff within a span of fifteen years. 

The study area was found to have high rainfall of approximately 1100mm annually (Table 4.5). 

However, it can fall below 1000mm for some drought years like in the year 2000. Despite rainfall 

occurring in up to one hundred days in a specific year, only thirty days on average were found to 

contribute water runoff amounting to approximately 20% of the total precipitation. Figure 4.10 

summarises the amount of rainfall and the resultant runoff depths. 

 

Figure 4.10: Relationship between Precipitation and Runoff depths 

Since the watershed is within the Aberdare ranges, the area is often covered with clouds almost 

throughout the year. This made it difficult to study a single month for the four epochs that were 

considered because the images with least cloud cover were considered. However, this did not affect 

the research because the images used were selected based on season they were acquired. 
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CHAPTER 5: CONCLUSIONS AND RECOMMENDATIONS 

5.1 Conclusions 

The potential volume of annual floodwaters for the Northern Collector Water Tunnel according 

this this study was found to range from low values like 791187.38 M3 during years with low 

precipitation to as high as 3678168.10 M3 during years with high precipitation (Table 4.6). Since 

the project is aimed at abstracting only 43% of the daily floodwaters which is equivalent to 513,388 

M3/day, this implies that the project will still not exhaust the flood waters during dry years with 

lowest rainfall like the case of the year 2003 which had the lowest runoff volume of 791187.38 

M3/day. This value is higher than the volume to be abstracted per day meaning some flood water 

will still be available to flow. This proves that areas downstream will not affected by the project. 

The changes in land use/cover within the watershed focused in the study are gradual and no 

significant change took place within the fifteen years epoch. This is confirmed by the stagnation 

of weighted CN value in all epochs. From Figure 4.9, the value of the CNs increasing at small 

decimal values is a clear evidence of the limited changes that are taking place. The runoff potential 

is directly proportional to these changes. It can be inferred that, although the runoff within the 

watershed is anticipated to increase according to this finding, it will take many years before a 

visible change takes place. 

More precipitation will result in increased surface runoff especially if it rains consecutively for 

many days. This is because the antecedent moisture condition(AMC) of the soil is a crucial factor 

determining runoff which is computed from the sum of five-day preceding precipitation. This 

means that rains falling for more than five consecutive days raises the AMC hence increasing the 

chances of more runoff. 

In summary, SCS-CN method has proved to work well when localised and applied to other places 

outside the United States of America like this case of the Northern Collector Water Tunnel project 

in Kenyan. The findings are comparable with the results obtained through measurement of the 

volumes of the rivers during dry season and wet seasons then estimating the runoff volumes. The 

application of this method can therefore be extended to other projects aiming at harvesting flood 

waters in Kenya. 
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5.2 Recommendations 

Due to unavailability of a weather station within the watershed, the weather station data used was 

from the nearest weather station in Nyeri town which is approximately 20Km away. Although both 

areas experience similar climatic conditions, better results could have been obtained if a weather 

station could have been established within the watershed. This could ensure better accuracy for the 

precipitation information for the watershed. This could be further improved if more than one 

weather stations are established within the watershed. 

Daily runoff volume for the watershed has been estimated based on the number of days that 

contributed runoff annually. This method of estimating daily runoff assumes that all the flood 

water flows away within the same day the precipitation occur. However ideally, runoff can last for 

some days after the precipitation. Therefore, there is need to distribute the flood waters according 

to some criteria that can be furthered through research. 
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APPENDICES 

7.1 Appendix A 

Table 7.1: Runoff curve numbers for hydrologic cover complexes (Antecedent moisture condition 

II and Ia=0.2 S) (Mishra & Singh, 2003) 

SI 

No

. 

Land use Description/Treatment Hydrologic 

Condition/% 

impervious 

area 

Hydrologic Soil 

Groups 

   
A B C D 

Urban 

1.  Residential: 
     

 
Average lot size-  1/8 acre or less 65* 77 85 90 92  
                                         1/4 acre 38* 61 75 83 87  
                                         1/3 acre 30* 57 72 81 86  
                                         1/2 acre 25* 54 70 80 85  
                                         1 acre 20* 51 68 79 84  
                                         2 acre 12* 46 65 77 82 

2.  Paved parking lots, roofs, driveways, etc. (excluding right-

of-way) 

 
98 98 98 98 

3.  Streets and roads: 
     

 
Paved with curbs and storm sewers (excluding right-of-

way) 

 
98 98 98 98 

 
Paved, open ditches (including right-of-way) 

 
82 89 92 93  

Gravel (including right-of-way) 
 

76 85 89 91  
Dirt (including right-of-way) 

 
72 82 87 89 

4.  Western desert areas: 
     

 
Natural desert landscaping (pervious areas only) 

 
63 77 85 88  

Artificial desert landscaping (impervious weed barrier, 

desert shrub with 1- to 2-inch sand or gravel mulch and 

basin borders) 

 
96 96 96 96 

5.  Urban districts: 
     

 
Commercial and business areas 85 89 92 94 95  
Industrial districts 72 81 88 91 93 

6.  Developing areas: 
     

 
Newly graded areas (pervious areas only, no vegetation)  77 86 91 94  
Idle lands 

     

7.  Open spaces, lawns, parks, golf courses, cemeteries, etc.  
    

 
Grass cover on 75% or more of the area Good 39 61 74 80  
Grass cover on 50% to 75% of the area Fair 49 69 79 84 

Agricultural  
Cultivated lands: 

     

8.  Fallow: 
     

 
Bare soil                                           Straight row ……. 77 86 91 94  
Crop residue cover Poor 76 85 90 93 
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Good 74 83 88 90 

9.  Row crops: 
     

 
                                                             Straight row Poor 72 81 88 91  
                                                             Straight row Good 67 78 85 89  
Crop residue cover       Straight row Poor 71 80 87 90  
Crop residue cover       Straight row Good 64 75 82 85  
                                         Contoured Poor 70 79 84 88  
                                         Contoured Good 65 75 82 86  
Crop residue cover        Contoured Poor 69 78 83 87  
Crop residue cover        Contoured Good 64 74 81 85  
                                         Contoured and terraced Poor 66 74 80 82  
                                         Contoured and terraced Good 62 71 78 81  
Crop residue cover        Contoured and terraced Poor 65 73 79 81  
Crop residue cover        Contoured and terraced Good 61 70 77 80 

10.  Small grain: 
     

 
                                                             Straight row Poor 65 76 84 88  
                                                             Straight row Good 63 75 83 87  
Crop residue cover       Straight row Poor 64 75 83 86  
Crop residue cover       Straight row Good 60 72 80 84  
                                         Contoured Poor 63 74 82 85  
                                         Contoured Good 61 73 81 84  
Crop residue cover        Contoured Poor 62 73 81 84  
Crop residue cover        Contoured Good 60 72 80 83  
                                         Contoured and terraced Poor 61 72 79 82  
                                         Contoured and terraced Good 59 70 78 81  
Crop residue cover        Contoured and terraced Poor 60 71 78 81  
Crop residue cover        Contoured and terraced Good 58 69 77 80 

11.  Close-seeded legumes or rotation meadow: 
     

 
                                                             Straight row Poor 66 77 85 89  
                                                             Straight row Good 58 72 81 85  
                                         Contoured Poor 64 75 83 85  
                                         Contoured Good 55 69 78 83  
                                         Contoured and terraced Poor 63 73 80 83  
                                         Contoured and terraced Good 51 67 76 80  
Uncultivated lands: 

     

12.  Pasture or range: Poor 68 79 86 89   
Fair 49 69 79 84   

Good 39 61 74 80  
                                         Contoured Poor 47 67 81 88  
                                         Contoured Fair 25 59 75 83  
                                         Contoured Good 6 35 70 79 

13.  Meadow- continuous grass, protected from grazing, and 

generally mowed for hay 

Good 30 58 71 78 

 
Brush-brush weed grass mixture with brush being the 

major element 

Poor 48 67 77 83 
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Fair 35 56 70 77   

Good 30 48 65 73 

14.  Farmsteads- buildings, lanes, driveways, and surrounding 

lots 

….. 59 74 82 86 

Woods and forests  
Humid rangelands or agricultural uncultivated lands: 

    

15.  Woods or forest land Poor 45 66 77 83   
Fair 36 60 73 79   

Good 25 55 70 77 

16.  Woods-grass combination (orchard or tree farm) Poor 57 73 82 86   
Fair 43 65 76 82   

Good 32 58 72 79  
Arid and Semiarid rangelands: 

     

17.  Herbaceous Poor 
 

80 87 93   
Fair 

 
71 81 89   

Good 
 

62 74 85 

18.  Oak-aspen Poor 
 

66 74 79   
Fair 

 
48 57 63   

Good 
 

30 41 48 

19.  Pinyon-juniper Poor 
 

75 85 89   
Fair 

 
58 73 80   

Good 
 

41 61 71 

20.  Sagebrush with grass understory Poor 
 

67 80 85   
Fair 

 
51 63 70   

Good 
 

35 47 55 

21.  Desert shrub Poor 63 77 85 88   
Fair 55 72 81 86   

Good 49 68 79 84 
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7.2 Appendix B 

Table 7.2: Curve numbers for three antecedent moisture conditions  (Mishra & Singh, 2003) 

I

D 

AMC II AMC I AMC III  I

D 

AMC II AMC I AMC III 

1 100 100 100 41 60 40 78 

2 99 97 100 42 59 39 77 

3 98 94 99 43 58 38 76 

4 97 91 99 44 57 37 75 

5 96 89 99 45 56 36 75 

6 95 87 98 46 55 35 74 

7 94 85 98 47 54 34 73 

8 93 83 98 48 53 33 72 

9 92 81 97 49 52 32 71 

10 91 80 97 50 51 31 70 

11 90 78 96 51 50 31 70 

12 89 76 96 52 49 30 69 

13 88 75 95 53 48 29 68 

14 87 73 95 54 47 28 67 

15 86 72 94 55 46 27 66 

16 85 70 94 56 45 26 65 

17 84 68 93 57 44 25 64 

18 83 67 93 58 43 25 63 

19 82 66 92 59 42 24 62 

20 81 64 92 60 41 23 61 

21 80 63 91 61 40 22 60 

22 79 62 91 62 39 21 59 

23 78 60 90 63 38 21 58 

24 77 59 89 64 37 20 57 

25 76 58 89 65 36 19 56 

26 75 57 88 66 35 18 55 

27 74 55 88 67 34 18 54 

28 73 54 87 68 33 17 53 

29 72 53 86 69 32 16 52 

30 71 52 86 70 31 16 51 

31 70 51 85 71 30 15 50 

32 69 50 84 72 
   

33 68 48 84 73 25 12 43 

34 67 47 83 74 20 9 37 

35 66 46 82 75 15 6 30 

36 65 45 82 76 10 4 22 

37 64 44 81 77 5 2 13 

38 63 43 80 78 0 0 0 

39 62 42 79  
   

40 61 41 78  
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7.3 Appendix C 

7.3.1 Appendix C1 

 Table 7.3: Accuracy assessment table for the year 2000 image 
 

 

 

 

 

 

 

 

 

 

 

7.3.2 Appendix C2 

Table 7.4: Accuracy assessment table for the year 2003 image 

2003 

Overall Classification Accuracy =97.50% 

Overall Kappa Statistics = 0.9667 
 

Rock Forest Built-up Agriculture Total User 

Rock 10 0 0 0 10 100 

       

Forest 0 9 0 1 10 90 

Built-up 0 0 10 0 10 100 

Agriculture 0 0 0 10 10 100 

Total 10 9 10 11 40 
 

Producer 100 100 100 90.91 
  

 

 

2000 

Overall Classification Accuracy =87.50% 

Overall Kappa Statistics =0.8333 

Unclassified Rock Forest Built-up Agriculture Total User 

Rock 10 0 0 0 10 100 

Forest 0 10 0 0 10 100 

Built-up 0 0 7 3 10 70 

Agriculture 0 1 1 8 10 80 

Total 10 11 8 11 40 
 

Producer 100 90.91 87.5 72.73 
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7.3.3 Appendix C3 

Table 7.5:  Accuracy assessment table for the year 2010 image 

2010 

Overall Classification Accuracy =90.0% 

Overall Kappa Statistics = 0.8667 
 

Rock Forest Built-up Agriculture Total User 

Rock 10 0 0 0 10 100 

Forest 0 9 0 1 10 90 

Built-up 0 0 7 3 10 70 

Agriculture 0 0 0 10 10 100 

Total 10 9 7 14 40 
 

Producer 100 100 100 71.43 
  

 

7.3.4 Appendix C4 

Table 7.6:  Accuracy assessment table for the year 2015 image 

2015 

Overall Classification Accuracy =87.50% 

Overall Kappa Statistics = 0.8333 
 

Rock Forest Built-up Agriculture Total User 

Rock 10 0 0 0 11 100 

Forest 0 9 0 1 11 90 

Built-up 0 0 8 2 8 80 

Agriculture 0 0 2 8 10 80 

Total 10 9 10 11 40 
 

Producer 100 100 80 72.73 
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7.4 Appendix D 

Table 7.7: Sample of Daily Rainfall-Runoff Computation for the year 2000 from Weather station data 

Day Month Year Daily 

rainfall 

(mm) 

5-day 

cumulative 

rainfall  

Season AMC 

condition 

Curve 

number 

(CN) 

Surface 

retention 

(S) 

Daily 

Runoff 

(mm) 

          

21 11 2000 0.762 12.446 G AMC I 68 110.1176471 0 

22 11 2000 21.082 13.208 G AMC I 68 110.1176471 0 

23 11 2000 0 33.528 G AMC I 68 110.1176471 0 

24 11 2000 14.986 32.766 G AMC I 68 110.1176471 0 

25 11 2000 9.906 36.83 G AMC II 84 44.57142857 0.001086435 

26 11 2000 34.036 46.736 G AMC II 84 44.57142857 8.157741334 

27 11 2000 6.096 80.01 G AMC III 93 17.61290323 0.241393039 

28 11 2000 0.762 65.024 G AMC III 93 17.61290323 0 

29 11 2000 7.112 65.786 G AMC III 93 17.61290323 0.482589746 

1 12 2000 0.762 57.912 G AMC III 93 17.61290323 0 

2 12 2000 6.096 48.768 G AMC II 84 44.57142857 0 

3 12 2000 13.97 20.828 G AMC I 68 110.1176471 0 

5 12 2000 0 28.702 G AMC I 68 110.1176471 0 

6 12 2000 0 27.94 G AMC I 68 110.1176471 0 

7 12 2000 0.762 20.828 G AMC I 68 110.1176471 0 

8 12 2000 0.762 20.828 G AMC I 68 110.1176471 0 

9 12 2000 10.922 15.494 G AMC I 68 110.1176471 0 

10 12 2000 4.064 12.446 G AMC I 68 110.1176471 0 

11 12 2000 0.508 16.51 G AMC I 68 110.1176471 0 
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12 12 2000 2.032 17.018 G AMC I 68 110.1176471 0 

13 12 2000 5.08 18.288 G AMC I 68 110.1176471 0 

14 12 2000 0 22.606 G AMC I 68 110.1176471 0 

15 12 2000 0 11.684 G AMC I 68 110.1176471 0 

16 12 2000 0 7.62 G AMC I 68 110.1176471 0 

17 12 2000 70.104 7.112 G AMC I 68 110.1176471 12.87816262 

18 12 2000 22.098 75.184 G AMC III 93 17.61290323 8.930949988 

19 12 2000 0 92.202 G AMC III 93 17.61290323 0 

20 12 2000 0.762 92.202 G AMC III 93 17.61290323 0 

21 12 2000 0 92.964 G AMC III 93 17.61290323 0 

22 12 2000 0 92.964 G AMC III 93 17.61290323 0 

23 12 2000 0 22.86 G AMC I 68 110.1176471 0 

24 12 2000 0 0.762 G AMC I 68 110.1176471 0 

25 12 2000 0 0.762 G AMC I 68 110.1176471 0 

26 12 2000 0 0 G AMC I 68 110.1176471 0 

27 12 2000 7.112 0 G AMC I 68 110.1176471 0 

28 12 2000 0 7.112 G AMC I 68 110.1176471 0 

29 12 2000 0 7.112 G AMC I 68 110.1176471 0 

30 12 2000 0 7.112 G AMC I 68 110.1176471 0 

31 12 2000 0 7.112 G AMC I 68 110.1176471 0 

TOTAL 562.61  34.16836112 

 


